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Alchemist
CP Cost - 5

The Alchemist is a character who has honed their ability to mix ingredients to create powerful Oils
(defensive), Elixirs (curative), and Poisons (offensive). These are a list of the Infusion skills that you can
purchase. What you are able to make with Alchemy and the production system is fully described in the
Production Companion Rulebook.
Alchemist 5
Improved Alchemy*
Quick Alchemy
Apply Poison

CP
Cost
2
4
2

Prerequisite

Attribute

Abilities

-

Passive
Passive
Passive

Alchemist is capable of making more complex Concoctions
Alchemist makes items faster than normal (8/game day)
Allows you to apply Alchemical Poisons to Weapon w/ 3
sec. rp
Increases capacity of Flask by 5 sections, max. 20

Intricate Flask*

2

-

Passive

Poison Mastery*

2

Apply Poison

Passive

May apply an additional Poison to your weapon; Max of 2
Purchases

Caustic Mixture*

2

-

Passive

Dilution

3

-

1 Water

Extended Mixture*

1

-

Passive

Expanded
Laboratory*
Layering Oil

2

-

Passive

Alchemist can spend 60 sec. rp at Alchemy Lab to create an
acidic mixture in their Flask, “2 Damage by Acid,” 3/Flask
Alchemist can dilute a Concoction at Alchemist Lab, Flask
will now contain 2 copies of the Concoction
Hardened Flask; Alchemist may carry over one
mixture/Concoction from Flask till next event
Increases maximum Pure Matter by 10 (Max 40)

3

-

Passive

Memorize Recipe*
Potent Poisons

1
2

-

Passive
1 Earth

Alchemist can apply second Oil to their clothes, must be
different from first Oil
Memorize Recipe to create Alchemical Concoction
When applying Poison to weapon, Alchemist may “Imbue
by Alchemy,” for “Double…” before 1 attack call

Improved Alchemy*
CP Cost - 2
The Alchemist is capable of making more complex Concoctions. The Alchemist is capable of making the next level of
Concoctions. This can be purchased three times, to gain access to level 2, level 3, and level 4 Concoctions respectively.

Quick Alchemy
CP Cost - 4
The Alchemist is capable of making items faster than normal. The Alchemist can now make up to 8 items per game day.

Apply Poison
CP Cost - 2
This Passive Ability allows you apply Alchemical Poisons to a weapon with 3 seconds of roleplay.

Intricate Flask*
CP Cost - 2
The Alchemist has a more intricate Flask. This skill increases the capacity of the Flask by 5 sections. This can be
purchased up to two times, increasing the number of sections in the Flask up to a maximum of 20.

Poison Mastery*
CP Cost - 2
Prerequisite: Apply Poison

This Passive Ability allows you to apply an additional poison to a weapon. This skill may be purchased twice. When
multiple poisons are applied, the Assassin may choose which one to use first. If a weapon with more than 1 Poison is
Author: Bill Tobin, Copyright 2013
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wielded by someone without the Poison Mastery skill, all poisons become inert and useless until wielded by a person
with the Poison Mastery skill.

Caustic Mixture*
CP Cost - 2
The Alchemist can produce acidic mixtures that can be used to damage others. The Alchemist can spend 60 seconds at
the Alchemy Lab and spend 1 pure matter in order to create an acidic mixture in their Flask. This can then be used to
damage others. Touch a packet to the opening of the Flask, and then throw the packet for “2 Damage by Acid.” This
ability is exhausted whether the attack hits or not. This mixture takes up one section in the Flask, and a Flask can never
have more than three caustic mixtures in it at any time. The first time this skill is purchased, you can have up to 3 caustic
mixtures in your flask. This skill can be purchased multiple times, with each purchase increasing the maximum number
of caustic mixtures that can be held in a Flask by one.

Dilution
CP Cost - 3
The Alchemist can dilute a Concoction while maintaining its potency. When placing a Concoction in a Flask at an
Alchemist Lab, the Alchemist may spend 1 Water and 1 Pure Matter to dilute the Concoction. The Flask now contains
two copies of the Concoction (and takes up twice the number of sections). If there is not enough room in the Flask to fit
two copies of the Concoction, this ability cannot be used.

Extended Mixture
CP Cost - 1
The Alchemist has hardened their Flask to protect substances indefinitely. Each time this skill is purchased, the
Alchemist may carry over one mixture or Concoction from the Flask until their next event. This mixture/Concoction will
still be in the Flask and still cannot be bottled. This can be purchased a maximum of 3 times.

Expanded Laboratory*
CP Cost - 2
This skill increases the maximum number of Pure Matter that can be stored in an Alchemy laboratory by 10. This can be
purchased a maximum of two times, increasing the maximum Pure Matter storage to 40.

Layering Oil
CP Cost - 3
The Alchemist knows the most efficient way to protect themselves with Oils. An Alchemist who has purchased this skill
can apply a second Oil to their own clothes. The second Oil must be different than the first, as per the rules regarding
Granted Defenses.

Memorize Recipe*
CP Cost - 1
The Alchemist can memorize a complex recipe. When purchased, the Alchemist may pick a Recipe they possess and
expend a charge from that recipe. The Alchemist may now create one copy of that Concoction per day. Only one recipe
may be memorized per event. When memorized, record on your character sheet “Memorized Recipe: <Recipe Name>.”
This skill may be purchased multiple times, each time granting access to a different recipe, or granting the ability to create
an additional copy of a known recipe per day. The Alchemist must have the ability to create a substance of the required
level to memorize the recipe.

Potent Poisons
CP Cost - 2
The Alchemist knows exactly how to apply a Poison to do the most damage. When applying a Poison to a weapon, the
Alchemist may spend 1 Earth and call “Imbue by Alchemy.” When swinging the Poison effect of that weapon, the user
may call “Double…” before the attack call. This has no effect on a Poison that already has the Double or Triple modifier.
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The Basics – All about Concoctions
Every Alchemist is able to create 5 Alchemical Concoctions each day. Alchemists start with access to the Level 1
Concoctions, but may purchase the Improved Alchemy skill to create more advanced recipes.
To create a Concoction, you must have the Alchemy skill and you must have access to the recipe for that
particular Concoction. Many Concoctions are considered common, and the recipes are readily available. Any Concoctions
that list a recipe requirement are considered somewhat rare, and a recipe must be found before the Concoction can be
made. Recipes also have charges, and each Concoction made from a recipe will use a charge from a recipe. Once a recipe
is out of charges, it can no longer be used to create Concoctions. The Alchemist must have the required level of Alchemy
needed to produce the concoction in order to use a recipe.
Most Concoctions are made using a variety of mundane ingredients that are readily available. In these cases, all
that is required is an amount of gold in order to obtain those ingredients. Any specific ingredients listed in the cost of a
Concoction are considered rare and limited, and must be found by the character before they can make that Concoction.
Concoctions take a lot of time to prepare and must be made before the event. In order to create Concoctions, a
character is required to submit an Alchemy sheet during check in or check out, or by contacting logistics between events,
and must pay the cost of the Concoctions.
Unless otherwise noted, Concoctions will last approximately one year before their magic fades. Anyone is capable
of using a bottled Concoction, but Concoctions placed in an Alchemists Flask cannot be used by anyone but the
Alchemist.
An Alchemist uses an Alchemy Lab to perform actions in-game. The Alchemy Lab is represented by a table or a
stand covered in bottles, flasks, and other scientific equipment. This area should be about 3’ x 3’. More then one Alchemist
may use the same Lab. Due to the volatile nature of Alchemical mixtures, the lab cannot be moved. Each Alchemy Lab
holds Pure Matter, which is used to create mixtures and oils. At check in, the Alchemist may refill his Alchemy Lab at a
cost of 1g per 10 Pure Matter, up to the maximum of 20 Pure Matter, and will receive a tag for the Pure Matter. Each time
a point is used, simply mark it on the tag. Each Alchemist has an independent store of Pure Matter and no other character
may use this Pure Matter.
The three most common types of Concoctions are Elixirs, Poisons, and Oils.

Alchemist’s Flask
Every Alchemist carries Alchemist’s Flask. Alchemy Flasks can be used to store Concoctions for quick use.
Additionally, Alchemists have many skills that allow them to perform Alchemical feats with substances in their Flask. An
Alchemist’s Flask is divided into sections, which allow the Alchemist to store multiple substances in one container. The
standard Flask has 10 sections, but there are skills that allow the expansion of this Flask. Every Concoction can be placed
in a Flask at an Alchemist’s Lab with 60 seconds of roleplay. The tag is placed in the Flask and should be marked “Flask,”
because substances in a Flask cannot be taken back out and will expire at the end of the event.
The benefit of the flask is that it allows for easy use of concoctions. In order to use a Poison or an Oil from a Flask,
simply touch a packet to the opening of the flask and then touch it to the target of the concoction. This does not decrease
the time it takes to apply oils or poisons, but you may do so without reading the tag. Elixirs in a flask may be delivered
with 3 seconds of roleplay without having to read the tag.
A Flask must be a container that can be closed that is at least 6” tall and must be able to store tags. The Flask must
be made in a safe manner, using materials that will not break easily and do not have sharp edges. Alchemists are
encouraged to decorate their Flask.

Poisons
Poisons are Concoctions that applied to weapons to cause devastating effects. Poisons affect the character through
their blood, so they can only be administered via a weapon. Poisons that are ingested are consumed for no effect. Poisons
cannot be applied to claws.
Each Poison can be applied by spending 60 seconds roleplaying coating the weapon in Poison. At the end of the
roleplay, the character must touch a packet to the vial and then to the weapon and calls “Imbue by Poison.” That weapon
is now capable of swinging an effect based on the particular Poison used. A player may swing that effect until a character
calls a defense or roleplays taking the effect. A weapon coated in Poison cannot be used for any other offensive strikes,
and the Poison is consumed if the player loses possession of the weapon or if the weapon is used for any other attack.
Some effects may exist that improve the use of Poison.
Alchemists may also place Poisons into their Flask. This requires 60 seconds of roleplay at an Alchemist lab. At
the end of 60 seconds, the Alchemist marks the Concoction tag as “Flask” and places it in the Flask. Each Poison takes up
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1 section in the Flask, unless otherwise noted on the tag. Elixirs in a Flask last until the end of the event, but may be
extended from other Alchemist skills.
Poisons are represented by vials. These vials need to be large enough to hold the tag or to have the tag attached
to the item, and must be able to hold liquid.

Elixirs
Elixirs are Concoctions that are ingested for beneficial effects. These effects could include Healing, Resists, and
Grant effects.
Bottled Elixirs are ingested by performing 3 seconds roleplay drinking the substance. At that point, the character
receiving the effect must read the tag, to know what effect happens. In-game, the time required to read the tag represents
disorientation before the effect sets in. If it is too dark to read the tag, an Elixir cannot be used. The character takes all
effects on the tag, including any side effects. Additionally, you may feed an Elixir to someone by performing 3 seconds of
roleplay feeding it to him or her, whereupon you will deliver the effect via touch.
Elixirs in an Alchemist’s Flask are ingested by performing 3 seconds of roleplay. If the Alchemist is applying it to
another character, they state the effect. There is no need to read a tag, and therefore no need for light.
Elixirs can only be identified by an Alchemist. Doing so requires the amount of time it takes to read the tag. If
the Elixir has a side effect, the Alchemist takes this effect when identifying it.
Alchemists may also place Elixirs into their Flask. This requires 60 seconds of roleplay at an Alchemist lab. At
the end of this 60 seconds, the Alchemist marks the Concoction tag as “Flask” and places it in the Flask. Each Elixir takes
up 1 section in the Flask, unless otherwise noted on the tag. Elixirs in a Flask last until the end of the event, but may be
extended from other Alchemist skills.
Elixir representations must be able to: be opened and closed, hold liquid, and be large enough to hold the tag or
have the tag attached to the representation.

Oils
Oils are alchemical substances that are applied to an individual’s clothes or armor to prevent certain attacks.
Oils are applied to an individual through 60 seconds of roleplay, followed by touching a packet to the tag and
then to the recipient. They are then handed the tag and call the effect. Characters may only benefit from a single Oil at
any time, and applying an Oil destroys any previously applied Oil.
Oils can only be identified by an Alchemist and takes as long as it takes to read the tag.
Alchemists may also place Oils into their Flask. This requires 60 seconds of roleplay at an Alchemist lab. At the
end of 60 seconds, the Alchemist marks the tag as “Flask” and places it in the Flask. Oil takes up 1 section in the Flask,
unless otherwise noted on the tag. Oils in a Flask last until the end of the event, but may be extended from other
Alchemist skills.
Elixir representations must be able to:
 Be opened and closed,
 Able hold liquid
 Be large enough to hold the tag or have the tag attached to the representation.
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Types of Alchemy
Below are the Poisons, Elixirs, and Oils you can make, once you purchase the appropriate Alchemist skills to do so.

Level 1 Concoctions
These Concoctions can be made by an Alchemist that has purchased the Alchemy Header.
Lesser Restoration Elixir: <Effect>
Cost: 1g
This produces an Elixir capable of fixing a specific effect from the list below. When applying this Elixir, call “Cure
<Effect> by Alchemy.”
Effects: Agony, Maim, Repel, Root, Slow
Minor Health Elixir
Cost: 1g
This produces an Elixir capable of healing the recipient. After drinking the Elixir, call “Heal 2 by Alchemy.”
Numbing Venom
Cost: 1g
This Poison can be applied to a weapon, to allow the user to swing “Slow by Poison.”
Pain Venom
Cost: 1g
This Poison can be applied to a weapon, to allow the user to swing “Agony by Poison.”
Pure Matter Elixir
Cost: 1g
This Elixir may be used on an Alchemist’s Lab to refill up to 10 Pure Matter. This only adds Pure Matter for the
Alchemist that uses the Elixir, and not to any other Alchemists using the same Lab.
Weapon Resistance Oil
Cost: 1g
This produces a vial of Oil that protects the user from weapons. “Grant Weapon Defense by Alchemy, Shield.”
Snake Bite Venom
Cost: 1g
This Poison can be applied to a weapon, to allow the user to swing “5 Damage by Poison.”

Level 2 Concoctions
These Concoctions can be made by an Alchemist that has purchased the Improved Alchemy skill at least once.
Anti-venom Elixir
Cost: 2g
This produces an Elixir capable of protecting the user from Poisons. After drinking the Elixir, call “Grant Poison Defense,
Shield.”
Corrupting Venom
Cost: 2g
This Poison can be applied to a weapon, to allow the user to swing “Stricken by Poison.”
Protective Oil - <Elemental/Mental/Metabolic/ or Physical>
Cost: 2g
This produces a vial of Oil which protects the user from various Trait groups. “Grant <Elemental/Mental/Metabolic/ or
Physical> Defense by Alchemy, Shield.”
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Restoration Elixir: <Effect>
Cost: 2g
This produces an Elixir capable of fixing a specific effect. When applying this Elixir, call “Cure <Effect> by Alchemy.”
Effects: Drain, Paralyze, Silence, Stricken, Stun.

Level 3 Concoctions
These Concoctions can be made by an Alchemist that has purchased the Improved Alchemy skill at least twice. These
Concoctions are considered Master Crafted, and possess the “Mastercraft” Trait.
Anti-Necrotic Oil
Cost: 5g
This produces a vial of Oil that protects the user from death. “Grant Death Defense by Alchemy, Shield.”
Nerve Freeze Venom
Cost: 3g
This Poison can be applied to a weapon, to allow the user to swing “Paralyze by Poison.”
Purging Elixir: <Trait Group>
Cost: 3g
This produces an Elixir capable of fixing a variety of effects. When applying this Elixir, call “Cure <Trait Group> by
Alchemy.”
Scorpion Venom
Cost: 3g
This Poison can be applied to a weapon, to allow the user to swing “Drain and 3 Damage by Poison.”

Level 4 Concoctions
These Concoctions can be made by an Alchemist that has purchased the Improved Alchemy skill three times. These
Concoctions are considered Master Crafted, and possess the “Mastercraft” Trait.
Life Elixir
Cost: 5g
This produces an Elixir capable of fixing death. When applying this Elixir, call “Cure Death and Heal 5 by Alchemy.”
Thick <Oil>
Cost: Varies
This produces a more protective version of one of the Alchemist Oils. This works the same as previous Oils, but call
“Double Grant…” in front of the effect. Thick Oils Cost 3 times more than the standard Oil effect.
Widowmaker Venom
Cost: 5g
This Poison can be applied to a weapon, to allow the user to swing “Death by Poison.”
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Infuser
CP Cost - 5
The Infuser is deeply in touch with magic and is capable of storing the magic in to powerful objects. They can
create up to 5 Level 1 Infusions per day. While the Infuser can create many wondrous items, they are most known for
creating Wands (spells effects), Potions (Restore Attributes), and Essences (Essence Collection).
Skill Name
Improved
Infusion*
Quick Infusion

CP Cost
2

Prerequisites
-

Attributes
Passive

4

-

Passive

Wand Mastery*
Drain Wand

2
3

-

Passive
Daily

Potion Potency
Overload Wand
Knowing
Another’s Art*

3
3
1

-

Passive
1 Fire
Passive

Abilities
Able to make more advanced Infusions
Capable of making items faster than normal (8/Game
Day)
Infuser may use Wand an additional time during battle
Infuser can drain Wand w/ at least 3 charges to refill own
magic reserves, “With Magic, Refresh 1 Spirit to Self”
Gain 1 Extra Attribute when using a Potion
“With Magic, Double (spell incant) when using a Wand
Infuser is skilled at creating Wands for spell they do not
know; must have recipe

Improved Infusion*
CP Cost – 2
The Infuser is capable of making more advanced Infusions. This skill can be purchased up to three times, and each
purchase grants access to higher level Infusions.

Quick Infusion
CP Cost – 4
The Infuser is capable of making items faster than normal. The Infuser can now make up to 8 items per game day.

Wand Mastery*
CP Cost – 2
The Infuser is experienced in the use of Wands. This skill allows the Infuser to use a Wand an additional time before
requiring Rest. This skill can be bought up to two times.

Drain Wand
CP Cost – 3
Once per day, the Infuser can drain a Wand in order to refill their own magic reserves. By completely draining a Wand
with at least 3 charges left, an Infuser can call “With Magic, Refresh 1 Spirit to Self.” This counts as a use of a Wand with
regards to requiring Rest. You may spend a Fate to use this Ability again. When doing so, the call is “With Fate, Refresh
1 Spirit to Self.”

Potion Potency
CP Cost – 3
This Passive ability grants the Infuser an extra Attribute when using a Potion to Refresh Earth, Fire, Air, or Water.

Overload Wand
CP Cost – 3
The Infuser can tap into the reserves of the Wand to perform great feats. By spending 1 Fire and using 2 charge of a
Wand, the Infuser may call “With Magic, Double…” before the normal call. This counts as a single use of a Wand with
regards to requiring Rest.
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Knowing Another’s Art*
CP Cost – 1
The Infuser can craft Wands for a Spell they do not know. When purchased, the Infuser may pick a recipe that they
possess and expend a charge from that Recipe. The Infuser may now create one copy of that Wand of that Spell per day.
Only one recipe may be memorized per event. When this skill is purchased, record on your character sheet “Knowing
Another’s Art: <Recipe Name>.” This skill may be purchased multiple times, each time granting access to a different
spell, or granting the ability to create an additional Wand of a known spell per day. The Infuser must have the ability to
create an Infusion of the required level to memorize the recipe.

The Basics – All about Infusions
Every Infuser is able to create 5 Infusions each day. Infusers start with access to the Level 1 Infusions, but may
purchase the Improved Infusion skill to create more advanced recipes.
To create an Infusion, you must have the Infusion skill and access to the recipe for that particular Infusion. Many
Infusions are considered common, and the recipes are readily available. Any Infusion that lists a recipe requirement is
considered somewhat rare, and a recipe must be found before the Infusion can be made. Recipes also have charges, and
each Infusion made from a recipe will use a charge from a recipe. Once a recipe is out of charges, it can no longer be used
to create Infusions.
Level 3 and Level 4 Infusions are considered Master Crafted, and possess the “Mastercraft” Trait.
Most Infusions are made using a variety of magical ingredients that are readily available. In these cases, all that is
required is an amount of gold in order to obtain those ingredients. Any specific ingredients listed in the cost of an
Infusion are considered rare and limited, and must be found by the character before they can make that Infusion.
Infusions take a lot of time to prepare. In order to create Infusions, a character is required to submit an Infusion
sheet when checking out, checking in, or between events by contacting Logistics, and must pay the cost of the Infusions.
Unless otherwise noted, Infusions will last approximately one year before their magic fades. Anyone is capable of
using an Infusion, but identification of an Infusion can only be performed by someone with the Infusion skill. This
identification takes as long as it takes the character to read the tag for the item.
An Infuser uses a Weave Tap to perform actions in-game. The Weave Tap is represented by a table or stand
covered in magical symbols and equipment. This area should be about 3’ x 3’. More then one Infuser may use the same
Weave Tap. Due to the nature of The Weave, the Weave Tap cannot be moved. At the moment, Weave Taps are used
primarily for rp benefits, but skills will be added soon that utilize the Weave Tap.
The three most common types of Infusions are Wands, Potions, and Essences.

Wands
Wands are implements that can be infused with magical spells. It is common to see these carried by spell casters,
but it is not unheard of for a fighter to carry them around.
Each Wand will have a single spell that it is attuned to and will be able to replicate. The Wand will have a
number of charges, which represents the number of times a spell can be cast before the magic on the Wand fades. The call
phrase for casting from a Wand is “With Magic, (Spell incant).” In order to use a wand, you must be touching or holding
a wand with an empty hand (this does not count as an item in hand with regard to spellcasting rules.) Casting a spell
from a Wand will use up a charge on the Wand, but will not require that any Attributes be spent by the character. If there
are no more charges on the Wand, the tag is destroyed.
Using a Wand is taxing for people who are unfamiliar with the process. For that reason, characters can only utilize
a single charge from any Wand before their mind is exhausted. That character must Rest for 5 minutes before they can use a
Wand again. Some Infusers have become accustomed to casting from Wands, and may be able to utilize multiple charges
before they need to Rest. An Infuser who picks up the Wand Mastery skill can use an additional charge before needing to
Rest. This skill can be purchased twice, for a maximum of three charges required before Rest.
In order to create a Wand, an Infuser must know the spell that is being put into the Wand. In order to broaden
the number of Wands that can be created, an Infuser must learn more spells. On rare occasion, an Infuser might find a
recipe that permits them to create a Wand for a spell they do not know. These recipes are highly sought after, so finding
them might be difficult.
Wands are represented by sticks or rods that are 6” to 12” in length. These can be made out of wood or metal, as
long as there are no sharp parts that could cause a safety hazard. Infusers are encouraged to decorate the Wand to reflect
the spell being stored. A Wand with a flame spell may be made out of metal and painted red with flicks of yellow, while
a Wand with necromancy may be made of withered wood painted black.
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Potions
Unlike Elixirs, which have particular effects upon a person, Potions are used to Restore magic within a character.
Most commonly, Potions are used to Restore the four basic Attributes. However, there may be Potions that are
capable of Restoring Spirit Attribute or daily skills. And in rare circumstances, there may be Potions capable of granting
or removing character traits.
Potions used to Refresh Attributes will not increase Attribute levels to higher than the character’s maximum,
unless otherwise specified.
Potions can only be identified by an Infuser, but are usually marked with a symbol or color to designate what
they do. Keep in mind that this is an in-game designation used by a particular character and each may use a different
marking system.
Using a Potion requires three seconds of roleplay, after which the character must read the tag, in order to confirm
that the Potion actually does what they think it does. If it is too dark to read the tag, then the Potion cannot be used. In
game, this process is explained by some disorientation before the effect happens (to explain the time to read the tag), and
that light is a catalyst required for the Potions to work (to explain that it must be light enough out to read the tag).
Potion representations must be able to:
1. Be opened and closed
2. Hold liquid
3. Hold the Potion tag or be able to have it attached

Essences
Essences are required by spell casters in order to complete High Magic Spells. Each ritual expends a number of
Essences. Between events Infusers are capable of creating Essences. You will submit what Essences you want along with
your normal production turn in and will receive them at the start of the event.
There are five types of Essences – Spring, Summer, Autumn, Winter, and Neverwas. For more information on
High Magic, please refer to the High Magic Rulebook Companion.

Types of Infusions
Below are the Wands, Potions, and High Magic Vessels you can make, once you purchase the appropriate Infuser skills to
do so.

Level 1 Infusions
These Infusions can be made by any Infuser.
Lesser Attribute Potion: <Type>
Cost: 2g
This produces a Potion that Restores 1 point in one of the 4 basic Attributes. The Potion is specific and the Attribute it
chosen when it is created. After drinking the Potion, the character would call “Refresh <Attribute>” with the Attribute
being Earth, Fire, Air, or Water.
Lesser Magic Wand: <Spell>
Cost: 2g, Recipe (optional)
This produces a magic Wand with 5 charges that can contain the effects of any spell on the Infuser’s character card with
an Attribute cost of 1 or less, and cannot contain daily spells. Casting a spell from a Wand consumes one charge, but does
cost any Attributes. A specific recipe may be used in order to create a Wand for a spell that is not on the Infuser’s
character card.
Minor <Type> Essence Collection
Cost: 2g
This allows the Infuser to collect 1 Essence of one of the following type: Spring, Summer, Autumn, Winter, and Neverwas.
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Level 2 Infusions
These Infusions can be made by an Infuser that has purchased the Improved Infusion skill at least once.
Quality Attribute Potion: <Type>
Cost: 4g
This produces a Potion that Restores 2 points in one of the 4 basic Attributes. The Potion is specific and the Attribute it
chosen when it is created. After drinking the Potion, the character would call “Refresh 2 <Attribute>” with the Attribute
being Earth, Fire, Air, or Water.
Quality Magic Wand: <Spell>
Cost: 5g, Recipe (optional)
This produces a magic Wand with 5 charges that can contain the effects of any spell on the Infuser’s character card with
an Attribute cost of 2 or less, and cannot contain daily spells. Casting a spell from a Wand consumes one charge, but does
cost any Attributes. A specific recipe may be used in order to create a Wand for a spell that is not on the Infuser’s
character card.
Intermediate <Type> Essence Collection
Cost: 5g
This allows the Infuser to collect 2 Essence of one of the following type: Spring, Summer, Autumn, Winter, and Neverwas.

Level 3 Infusions
These Infusions can be made by an Infuser that has purchased the Improved Infusion skill at least twice. These Infusions
are considered Master Crafted, and possess the “Mastercraft” trait.
Greater Attribute Potion: <Type>
Cost: 6g
This produces a Potion that Restores 3 points in one of the 4 Basic Attributes. The Potion is specific and the Attribute is
chosen when it is created. After drinking the Potion, the character would call “Refresh 3 <Attribute>” with the Attribute
being Earth, Fire, Air, or Water.
Greater Magic Wand: <Spell>
Cost: 9g, Recipe (optional)
This produces a magic Wand with 5 charges that can contain the effects of any spell on the Infuser’s character card with
an Attribute cost of 3 or less, and cannot contain daily spells. Casting a spell from a Wand consumes one charge, but does
cost any Attributes. A specific recipe may be used in order to create a Wand for a spell that that is not on the Infuser’s
character card.
Greater Essence Collection <Type>
Cost: 9g
This allows the Infuser to collect 3 Essences of one of the following type: Spring, Summer, Autumn, Winter, and
Neverwas.

Level 4 Infusions
These Infusions can be made by an Infuser that has purchased the Improved Infusion skill three times. These Infusions
are considered Master Crafted, and possess the “Mastercraft” Trait.
Master Attribute Potion: Spirit
Cost: 10g
This produces a Potion that Restores 1 Spirit at the cost of 1 Fate. After drinking the Potion, the character would call
“With Fate, Refresh Spirit.”
Mater Magic Wand: <Spell>
Cost: 15g, Recipe (optional)
This produces a magic Wand with 3 charges that can contain the effects of any daily spell on the Infuser’s character card.
Casting a spell from a Wand consumes one charge. A specific recipe may be used in order to create a Wand for a spell is
not on the Infuser’s character card.
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Master <Type> Essence Collection
Cost: 14g
This allows the Infuser to collect 4 Essence of one of the following type: Spring, Summer, Autumn, Winter, and Neverwas.
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Runesmith
CP Cost - 5
The Runesmith is a character that is skilled in armor and weapon construction. In addition to being a spectacular
mundane craftsman, they have become very skilled at enhancing craftsmanship. It does not make the object magical, but
instead enhances a weapon/armor’s natural abilities. A Runesmith is capable of making Weapon/Armor Runes, Flesh
Runes, and Portal Runes.
What you are able to make with Runesmithing once the appropriate skills are purchased and a full description of
how Runes work can be found in the Production Companion Rulebook.
Runesmith 5

CP
Cost
0
2

Prerequisite

Attributes

-

Passive
Passive

May engrave Runes onto Weapons/Armor at Forge
May make more advanced Runes; Max of 3 Purchases

4
2

-

Passive
Passive

Expert Smithing

3

-

Passive

Scarred Flesh
Call the Armor

3
2

Passive
1 Water

Call the Weapon

2

Fingernail Etchings

3

Expert
Smithing
Expert
Smithing
Engrave Rune

May make Runes faster than normal (8/Game Day)
May use 2 additional Weapon/Armor Runes; Max of 2
Purchases
May Repair Weapons/Shields/Items/Armor without
Forge.
Runesmith gains 2 uses when consuming Flesh Runes
3 Seconds rp, “Refresh All Armor by Awe”

Runic Reinforcement

2

-

1 Earth &
1 Vitality
Passive

Runic Extension*

1

-

Passive

Heavily Armored*

2

Armored

Passive

Engrave Rune
Improved
Runesmithing*
Quick Runesmithing
Runic Mastery*

1 Fire

Abilities

3 Seconds of rp, “Repair Weapon by Awe” or “Repair
Shield by Awe”
60 Seconds to etch Weapon/Armor Rune w/o use of
Forge, “Imbue Rune by Awe”
Use any Weapon/Armor Rune to Repair Weapon or
Refresh Armor; “Refresh All Armor by Rune” or “Repair
Weapon by Rune”
Extend Armor, Weapon, or Flesh Runes beyond end of
the event; Max of 3 Purchases
Gain 1 Armor Point; Max of 3 Purchases

Engrave Rune
CP Cost – 0
The Runesmith may engrave Runes onto weapons and armor at a Forge. These Runes will have no effect until they are
engraved. Engraving a Rune take 10 seconds of roleplay at a Forge. More information on Runes is available in the
Production Companion Rulebook.

Improved Runesmithing*
CP Cost – 2
The Runesmith is capable of making more advanced Runes. This skill can be purchased up to three times with each
purchase granting access to higher-level Runes.

Quick Runesmithing
CP Cost – 4
The Runesmith is capable of making items faster than normal. The Runesmith can now make up to 8 Runes per Game
Day.

Runic Mastery*
CP Cost – 2
The Runesmith is better attuned to his equipment. This skill allows the Runesmith’s Armor and Weapons to benefit from
2 additional Runes beyond the maximum of 3. This skill can be bought twice, allowing the Runesmith to have a
maximum of 7 Runes on their armor and weapons.
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Expert Smithing
CP Cost – 3
The Runesmith is experienced at common weapon and item repairs. The Runesmith can spend 60 seconds of roleplay
with a tool to repair armor, weapons, shields, and items without requiring a forge. This requires a metalworking
representation with no sharp edges. At the end of 60 seconds, call “Refresh All Armor”, “Repair Weapon”, “Repair
Shield”, or “Repair Item.”

Scarred Flesh
CP Cost – 3
The Runesmith is used to scarring his flesh and is better able to utilize Flesh Runes. Any Flesh Rune on the Runesmith’s
body can be consumed twice before the magic fades. Flesh Runes that have been used once cannot be extended with the
Runic Extension skill. This has no effect on passive Flesh Runes that are not consumed when used.

Call the Armor
CP Cost – 2
While the Runesmith typically fixes armor with tools, they are also capable of talking to the spirits of the armor. By
roleplaying talking to someone’s armor for 3 seconds and spending 1 Water, the Runesmith may call “Refresh All Armor
by Awe.” If the person wearing the armor or any of their possessions is hit with any weapon, missile, or packet attack
during this process, the effect is interrupted and no Attributes are spent.

Call the Weapon
CP Cost – 2
While the Runesmith typically fixes a weapon or shield with tools, they are also capable of talking to the spirits of those
items. By roleplaying talking to someone’s weapon for 3 seconds and spending 1 Fire, the Runesmith may call “Repair
Weapon by Awe” or “Repair Shield by Awe.” If the person wielding the weapon or any of their possessions is hit with
any weapon, missile, or packet attack during this process, the effect is interrupted and no Attributes are spent.

Fingernail Etchings
CP Cost – 3
The Runesmith can put an etching on a Weapon or Armor with their bare hands. A Runesmith can etch a Rune onto
Armor or a Weapon without the use of a forge. After 60 seconds of roleplaying etching a Rune onto the item with their
fingers, the Runesmith may spend 1 Earth and 1 Vitality to call “Imbue Rune by Awe.” If this would drop the Runesmith
to 0 Vitality, they will fall Unconscious Stable.

Runic Reinforcement
CP Cost – 2
The Runesmith is capable of convincing his Armor and Weapon to continue battle. A Runesmith may consume any
Armor Rune on their armor to call “Refresh All Armor by Rune” and consume any Weapon Rune on their Weapon to call
“Repair Weapon by Rune.” The Rune used to perform this action immediately fades, regardless of its normal duration.

Runic Extension*
CP Cost – 1
The Runesmith is capable of extending Runes on their Armor, Weapons, and Flesh indefinitely. For each purchase of this
skill, the Runesmith may extend one Rune that would normally expire at the end of the event. The next time that
character plays, they will start the game with that Rune on their Armor, Weapon or Flesh. This skill can be purchased a
maximum of 3 times.

Heavily Armored 2*
CP Cost – 2
Prerequisite: Armored
This Passive ability adds gives the character access to more armor. The character gains 1 point of Armor. In order to gain
the benefit of this skill, you must be wearing Leather, Chain, or Plate armor. This skill can be bought up to 3 times, and a
character can never have more than 4 points of Passive Armor. This skill does not count as a prerequisite for other skills
under this Header.
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The Basics – All about Runesmithing and Runes
Every Runesmith is able to create 5 Runes each day. Runesmiths start with access to the Level 1 Runes, but may
purchase the Improved Runesmithing skill to create more advanced recipes.
To create a Rune, you must have the Runesmithing skill and you must have access to the recipe for that particular
Rune. Many Runes are considered common, and the recipes are readily available. Any Rune that lists a recipe
requirement is considered somewhat rare, and a recipe must be found before the Rune can be made. Recipes also have
charges, and each Rune made from a recipe will use a charge from a recipe. Once a recipe is out of charges, it can no
longer be used to create Runes.
Level 3 and Level 4 Runes have the “Mastercraft” Trait.
Most Runes are made using a variety of mundane supplies that are readily available. In these cases, all that is
required is an amount of gold in order to obtain those supplies. Any specific ingredients listed in the cost of a Rune are
considered rare and limited, and must be found by the character before they can make that Rune.
Runes take a lot of time to prepare. In order to create Runes, a character is required to submit a Runesmithing
sheet when checking out, checking in, or between events by contacting logistics, and must pay the cost for the Runes.
Unless otherwise noted, Runes that have not been etched will last approximately one year before they lose their power.
Runesmiths can etch Runes into an item or structure to activate them. Etched Runes normally last until they are used or
until the end of the event. Anyone is capable of using a Rune once they are etched onto an item.
A Runesmith uses a Forge to perform actions in-game. While a Runesmith can use any Forge for mundane tasks,
they can only be attuned to a single Forge at any time. The Forge is represented by a table or a stand covered in
metalworking tools. This area should be about 3’ x 3’. Due to weight of the equipment and the time to set it up, the forge
cannot be moved in-game.
The four most common types of Runes are Weapon Runes, Armor Runes, Flesh Runes, and Portal Runes.

Weapon and Armor Runes
Weapon and Armor Runes are etchings that can be placed on weapons, shields, and armor to enhance their
abilities. These enhancements can be anything from allowing Armor to be repaired quickly or for a weapon to hold
Poisons until the user wants to use them. Shields count as weapons in regards to what Runes may be placed on them.
Runes may not be placed on claws, unless specified by the recipe.
Each Rune will have a specific effect they perform. Many Runes will be completely expended whenever used,
while some may have a Passive effect that lasts until the end of the current event. Any character can have a total of 3
Armor and/or Weapon Runes etched on their person at any given time, but some Runesmiths can increase that total.
Runes can be etched on armor or weapons by a Runesmith. This is normally done at the Runesmith’s attuned Forge, but
some skills may allow them to etch Runes in other ways. When used, Runes normally add the trait “By Rune” to indicate
where the effect was coming from.
Armor and Weapon Runes are represented by Runes drawn on paper or parchment. Once Runes have been
applied to Weapons or Armor, the power of the Rune is absorbed into the Metal or Leather and is no longer visible.

Flesh Runes
While placing Runes onto Armor and Weapons is considered a common occurrence, burning Runes onto one’s
flesh is a little less common and a little less socially acceptable. Many Runesmiths find Flesh Runes to be appalling and
consider it to be a twisted mutation of what Runesmithing is about. Despite this line of thought, Flesh Runes can
certainly be utilized to good effect.
Flesh Runes can be applied by a Runesmith at their attuned Forge. This requires 60 seconds of roleplay, where the
Runesmith brands the Rune onto the target. Please do not use any actual fire to represent this! At the end of 60 seconds,
call “Imbue Flesh by Rune.” The target of the Flesh Rune gains the power of the Rune, but also gains the “Flesh”
character trait.
A character may only have a single Flesh Rune on their body at any given time. In order to utilize the power of
the Rune, the Rune must be exposed and visible. It can, however, be hidden until a time when its power is required.
Once a Flesh Rune’s power is utilized, it will soon disappear from the character’s skin, and the “Flesh” character trait is
lost.
Unapplied Flesh Runes are represented with a drawing on paper or parchment. Once applied, a Flesh Rune is
represented with a pattern or picture on the character’s skin. This should be applied by make-up that can be easily
removed but will not stain a character’s costume. This Rune should cover a minimum of a 1” x 1” space of skin. In order
to use a Rune, the representation of the Rune must be exposed. Once a Rune is used, the player may remove the
representation at their first convenience. They will not lose the “Flesh” trait until this representation is removed.
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Portal Runes
Portal Runes are Runes that bring out the power of a particular doorway or portal. They can be applied to the doorway,
and will affect people trying to move through the portal. Portal Runes normally last one year, but once they have been
applied, they cannot be applied to a different Portal and will expire at the end of the event.
It takes 60 seconds to apply a Portal to a doorway. In this time, the player should hang up the Portal plaque and the
caution sign explaining the effects. The Runesmith applying the Portal Rune will automatically be attuned to that Rune.
The Runesmith may also attune anyone they choose who was within arm’s reach at the end of the 60 seconds. Rooms
with more than one doorway may place a representation on each doorway for a single tag. If representations aren’t put
up on both doorways, the doorway without the representation will not be protected in any way. This rule applies to tents
which have two entrances. As per WAR Accelerant rules, you cannot enter or exit through windows, so a portal rune is
not necessary there.
Once applied, the Portal Rune will affect people trying to pass through the portal. These effects can include a verbal
alarm, damage, effect, or refusal. Anyone who is attuned to the Portal Rune may trace the Rune for 3 seconds to bypass
the effects of the Rune. Additionally, anyone attuned to the Rune may trace the Rune for 3 seconds to allow others to
bypass the effects of the Rune. This effect will last until the Attuned character stops touching the Rune. Finally, anyone
attuned to a Portal Rune may deactivate the Portal Rune. After 60 seconds of roleplay, the character may take down the
representation of the Portal Rune and gently place it on the ground. Anyone attuned to that Rune may put it back up
with 60 seconds of roleplay.
Anyone attuned to a Portal Rune may attune others. This requires 60 seconds of roleplay, etching the name of the person
to be attuned to the Rune. During this time, the player will add the target’s name to the list of people attuned to the Rune.
The person to be attuned must be within Arm’s reach during these 60 seconds and will record it upon their character
sheet at their earliest convenience.
Multiple Portal Runes may be placed on the same doorway or portal. However, you may only apply Portal Rune to a
Portal if you are currently attuned to all existing Portal Runes on that portal. Each Portal Rune will have its own
representation and caution sign.
Portal Runes are represented by a plaque of at least 3” x 3” with a Rune drawn or etched into it. There should be
sufficient room on the back of a Portal Rune to add a list of Attuned people and the tag for the Rune.

Types of Runes
Below are Weapon/Runes, Flesh Runes, and Portal Runes you can make, once you purchase the appropriate
Runesmithing skills to do so.

Level 1 Runes
These Runes can be made by any Runesmith.
Armor Rune of Repair
Cost: 1g
This Rune may be etched onto a suit of armor. This Rune allows the user to call “Refresh All Armor by Rune” once before
it disappears. This Rune lasts until all charges on it are consumed or until the end of the event, once etched.
Weapon Rune of Repair
Cost: 1g
This Rune may be etched onto a weapon or shield. This Rune allows the user to call “Repair Weapon by Rune” once
before it disappears. This Rune lasts until all charges on it are consumed or until the end of the event, once etched.
Portal Rune of Alarm
Cost: 2g
This Portal Rune may be etched onto a doorway. Anyone who triggers this Portal Rune must announce, in a loud voice,
“Alarm Rune! Alarm Rune! Alarm Rune!”. This Rune lasts until all charges on it are consumed or until the end of the
event, once etched.
Elemental Weapon Rune: <Trait>
Cost: 1g
This Rune may be etched onto a weapon. This Rune allows the user to call “5 Damage by <trait>.” Possible Traits include
Fire, Ice, Earth, and Lightning. This Rune lasts until all charges on it are consumed or until the end of the event, once
etched.
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Flesh Rune of Stability
Cost: 1g
This Rune may be etched onto someone’s skin. If the wearer is ever dropped to unconscious unstable, they may consume
this rune to call “Stabilize to Self by Rune.” This Rune lasts until all charges on it are consumed or until the end of the
event, once etched.

Level 2 Runes
These Runes can be made by a Runesmith that has purchased the Improved Runesmithing skill at least once.
Armor Rune of Protection
Cost: 2g
This Rune may be etched onto a suit of armor. This Rune allows the user to call “Reduced by Rune” against any one
attack with a Physical Trait. Instead of taking the effect, the character takes 1 point of damage. If this reduces the
character to 0 Vitality, they go Unconscious Stable. This Rune lasts until all charges on it are consumed or until the end of
the event, once etched.
Weapon Rune of Poisoning
Cost: 5g
This Rune may be etched onto a weapon. This Rune allows the owner to freely use a Poisoned weapon for normal
damage, without losing the effect of the Poison. Poison is still expended when it successfully strikes a target. This Rune
lasts until all charges on it are consumed or until the end of the event, once etched.
Weapon Rune of Parrying
Cost: 2g
This Rune may be etched onto a weapon or shield. This Rune allows the owner to call “Parry by Rune” against any one
weapon or missile attack. This Rune lasts until all charges on it are consumed or until the end of the event, once etched.
Portal Rune of Assault
Cost: 5g
This Portal Rune may be etched onto a doorway. Anyone who triggers this Portal Rune receives the effect “5 Damage by
Magic.” Once applied, this Rune lasts until the end of the event.
Armor Rune of Blade Turning
Cost: 2g
This Rune may be etched onto a suit of armor. If the character is brought to 0 Vitality by called damage from a melee or
missile attack, they can use the Rune to become stable. This Rune lasts until all charges on it are consumed or until the
end of the event, once etched.
Flesh Rune of Healing
Cost: 3g
This Rune may be etched onto someone’s skin. This Rune allows the user to add 2 to any “Heal” effect they use twice. If
both of these effects were delivered by touch, then the Rune may be used a third time. Finally, the Rune may be fully
consumed to call “Heal 2 to self by Rune.” This Rune lasts until all charges on it are consumed or until the end of the
event, once etched.

Level 3 Runes
These Runes can be made by a Runesmith that has purchased the Improved Runesmithing skill at least twice. These
Runes are considered Master Crafted, and possess the “Mastercraft” Trait.
Armor Rune of Reinforcement
Cost: 10g
This Rune may be etched onto a suit of armor. If the character has less than 4 points of Passive armor, this character is
under the effect of “Imbue by Rune.” While wearing that armor, the character has 1 additional point of Passive Armor.
This Rune stacks (up to a maximum of 4 armor) and also stacks with “Grant Armor” effects. This Rune lasts until all
charges on it are consumed or until the end of the event once etched.
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Armor Rune of Survival
Cost: 5g
This Rune may be etched onto a suit of armor. When struck by any Death effect, the character may call “Resist Death by
Rune.” This Rune will last until used or until the end of the event once etched.
Weapon Rune of Aggression
Cost: 10g
This Rune may be etched onto a melee weapon, thrown weapon or bow. This Rune allows the owner to add 1 to one
called melee strike with this weapon. This effect can be Refreshed by 5 minutes of Rest. This Rune lasts until all charges
on it are consumed or until the end of the event once etched.
Portal Rune of Protection
Cost: 10g
This Portal Rune must be etched onto a doorway to become active. As long as this Portal Rune is active, anyone not
invested cannot pass through the doorway. Mechanics for Portal Runes that allow a character to pass through without
triggering the Rune can be used to pass freely through the portal. Once applied, this Rune lasts until the end of the event.
While those not invested in the Portal Rune must be allowed into a portal protected by the rune, anyone may freely exit.
Flesh Rune of Skill
Cost: 10g
This Rune may be etched onto someone’s skin. This Rune will allow a character to reduce the Attribute cost of any ability
by 1 Attribute up to three times. This Rune lasts until all charges on it are consumed or until the end of the event, once
etched.

Level 4 Runes
These Runes can be made by a Runesmith that has purchased the Improved Runesmithing skill three times. These Runes
are considered Master Crafted, and possess the “Mastercraft” Trait.
Armor Rune of Expedious Repair
Cost: 15g
This Rune may be etched onto a suit of armor. This Rune allows the user to call “Refresh All Armor by Rune” once. This
effect can be Refreshed by 5 minutes of Rest. This Rune lasts until all charges on it are consumed or until the end of the
event once etched. A character may only have a single Armor Rune of Expedious Repair etched on their armor at any
time.
Weapon Rune of Defense
Cost: 15g
This Rune may be etched onto a weapon or shield. After Resting for 5 minutes, the character may call “Guard Weapon by
Rune” to negate the first melee or missile attack. This Rune lasts until all charges on it are consumed or until the end of
the event once etched. A character may only benefit from a Single Weapon Rune of Defense at any time.
Portal Rune of Closure
Cost: 10g
This Portal Rune may be etched onto a magical portal. This Rune will close the portal. In cases of permanent portals, this
Rune will make an active portal dormant. Please note that this effect may not be permanent, and portals may reactivate if
someone else is activating them. Once applied, these Runes disappear immediately upon etching.
Flesh Rune of Survival
Cost: 20g
This Rune may be etched onto someone’s skin. This Rune will allow a character to come back from the brink of death.
After being dead for five minutes, this character may spend this Rune and one fate to call “With Fate, Purge Death by
Rune” instead of becoming a dead spirit. Due to the unnatural effect of this Rune, some may consider this Rune to be as
nefarious as Necromancy. This Rune lasts until all charges on it are consumed or until the end of the event, once etched.
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All about Production Recipes
A character may find a recipe that allows them to make a specific production item. These recipes normally allow
5 items to be created before the recipe is destroyed. All Recipes should include:
Name of the Item
Production Type and Level
Cost to Create
Number of Charges
Effect
Special (any other requirements for creation)
As an example:
Recipe of Greater Magic Wand: Incinerate
Level 3 Infusion
Cost: 9 Gold
Charges: 5 (ooooo)
This Recipe allows you to create a "Wand of Incinerate." This wand has 5 charges and allows you to spend 1 charge to
throw a packet for "Death by Fire."

Author: Bill Tobin, Copyright 2013

23

